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Ambient Vibration H/V Spectral Ratio (HVSR) Method Data

Analysis and Archival Guidelines

Pre-Analysis Data Preparation

List of required items

o SD cards from the Nanometrics portable broadband seismometers

. A computer

List of required software

. Python 2.7 with the Scipy stack and the Obspy package.

° “reducemseedHVSR.py”

The Centaur data loggers are configured to continuously archive the data. At the
end of each hour, a data file in the miniseed format is created and stored on the
removable SD card. If tests are completed at multiple sites within a day, the
Centaur data logger may be continuously powered. At the end of the day, the
Centaur should be powered off and multiple miniseed data files will have been
created (one for each hour). These hour-long data files need to be merged
together and then sliced into individual files containing the data of interest for
each test/site. These sliced data files are used for HVSR processing.

Step-by-step instruction for merging and slicing the test data
1)  Copy the test data from the SD cards to a local hard drive, keeping them
in one folder for each instrument. The data will be organized by date
with an individual miniseed file for each hour the Centaur data logger
was powered on. Note that the Centaur data logger references the data
to Coordinated Universal Time (UTC), as obtained via GPS, not local time
(e.g., NZST or NZDT). For a field work day in NZ, the raw data likely will
be logged over two consecutive UTC days and should be put into a single
folder for merging and slicing, as shown in the figure below.

<« ~ A | | » ThisPC > OSDisk(C:) » Local » RawData

A
Name Date modified

D UC.S02._centaur-3_1912_20180828_180000.miniseed ~ 28/08/2018 7:00 PM

D UC.S02._centaur-3_1912_20180828_190000.miniseed  28/08/2018 8:00 PM

[7] uC.S02._centaur-3_1912_20180828_200000.miniseed ~ 28/08/2012 9:00 PM

[7] UC.502._centaur-3.1912_20180828_210000.miniseed  28/08/2012 10:00 PM

[7] uC.502._centaur-3_1912_20180828_220000.miniseed  28/08/2012 11:00 PM

D UC.S02._centaur-3_1912_20180828_230000.miniseed ~ 29/08/2018 12:00 AM

D UC.S02._centaur-3_1912_20180829_010000.miniseed ~ 29/02/2018 2:00 AM
D UC.S02._centaur-3_1912_20180829_020000.miniseed ~ 29/08/2012 3:00 AM

D UC.S02._centaur-3_1912_20180829_030000.miniseed  29/08/2012 4:00 AM
[7] uC.502._centaur-3_1912_20180829_040000.miniseed  29/02/2012 5:00 AM
D UC.S02._centaur-3_1912_20180829_050000.miniseed ~ 29/08/2018 6:00 AM

v O Search RawData

Type Size

MINISEED File
MINISEED File
MINISEED File
MINISEED File
MINISEED File
MINISEED File

o . - - LA L LD - X L L X KX L L 1 1 J
C.502. :entaur-?_ 152 0130@ ooooooﬁiﬁee‘d 29/08/20§1:00m RAINISEED File

MINISEED File
MINISEED File
MINISEED File
MINISEED File
MINISEED File

o

54KB
1,316 K8
1,311K8
1,313K8
1,507 KB
1,747 KB
TORKET
1,823KB
1,048 KB
1,833K8
1,880 KB
1,748 KB

D UC.S02._centaur-3_1912_20180829_060000.miniseed ~ 28/08/2018 6:16 AM

13 items

MINISEED File

354 k8|

=

Two Dates UTC
28/08/2018 UTC

28/09/2018 UTC
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Copy “reducemseedHVSR.py” into the data folder(s), which may be
downloaded from:

https://github.com/ucgmsim/TechPlatform2.

Create “testname.txt”, “starttime.txt”, and “endtime.txt” files, which
contain the test/site name, the test start date and time, and test end date
and time in plain text with one line per test/site. The site/test name
should be limited or abbreviated to 3 or 4 letters (e.g.; LOC1, LOCZ, and
LOC3; or BGPK, ABRD, ALBT) and match the name noted on the field
datasheet. The start and end dates and times need to been specified in
reference to UTC, not local NZ time. An example of the format of the test
name and the time (yyyymmddhhmmss) is shown below:

“testname.txt” “starttime.txt” “endtime.txt”
BGPK 20180828225000 20180828232000
ABRD 20180829000500 20180829003500

In the command prompt, navigate to the data folder and run the
following command:

python reducemseedHVSR.py

This will create a single file per test, which is automatically named using
the station network name (e.g., UC) and station number (e.g.,, SO2) which
have been set in the Centaur data logger and site/test name or
abbreviation (e.g., LOC1 or ARBD) as defined by you in “testname.txt”.
Example files names appear as follows:

UC.S02.BGPK.miniseed

UC.S02.ARBD.miniseed

Each file will contain three traces, one for each sensor component (i.e.,
vertical, horizontal north, and horizontal east).

The individual, sliced site/test miniseed files are the “raw data” used for
data archival and used to compute the H/V spectral ratio.
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H/V Spectral Ratio (HVSR) Processing Using Geopsy

Geopsy is an open source software package for geophysical research and analysis
which enables a quick assessment of the quality of the recorded data and HVSR
processing. Here we focus on the use of Geopsy, however other methods are
available to process this data.

List of required software
o Geopsy - www.geopsy.org

Step-by-step instruction
1) Load the measured ambient vibration data into Geopsy. This can be done
by drag-and-dropping the the sliced test miniseed files into the Geopsy
window. When the files are successfully loaded, they will appear in the
“Files” tab, as shown in the following figure.

& Geepsy
Pl [t Yew Welom oo Wedows Hep

pPHw ODEHED AEDBEEREEEEE
T e T S s« +

19 signals, 8 fles, free cacha 455 Mib

2)  Select an individual test miniseed file from the “Files” tab, and drag it to
the toolbar button labeled “H/V”.

15 signal, § e, free cache 6455 Mb &%
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The analysis parameters are selected in the H/V toolbox settings. The
appropriate parameterisation will vary depending on site characteristics
and should be discussed with research collaborators.

For a first level H/V analysis, only two parameters need to be changed
(as shown in the figure below): (1) The time window Length should be
changed to “Exactly” “60.00s”. (2) The Frequency sampling range should
be specified From “0.10 Hz” to “10.00 Hz” with a “Log” Step over “100”
Number of samples. Depending on site conditions and the length of the
record, these values can and should be varied. Begin the analysis by
clicking the “Start” button at the bottom of the “H/V toolbox” window.

Time  Processng  Output Time  Processng  Output
Global time range 2-)-Fre-qu-en:ys-am-p!i:g -------------------- 1
From sm | From [0.10Hz [2] to [10.00 12 B
To 35m0.0100s | st Number of samples [100 B
Reference signal | - P —
Time windows Page height Plots per line
Genersl  Rawsignal  Fiter  Fitered signal [ Resuts make-up [l
(0 e o=t || Camomce =
e -l v
Bad sample
[ Tolerance 0,00, : Oeep o0.00s. =
O Thveshold 0.00 :

[] Anti-triggering on raw signal
[ Anti-triggering on filtered signal

[ common [ Update
View |d stations ¥ | Number of windows
= || ===

Allow Geopsy to automatically select the time windows based on this
parameterisation by clicking the “Yes” button.

[ Calculating H/V 7 >

Mo windows have been selected. Do you want to select them
automatically with current parameters?
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5) The windowed time records and the computed H/V curves with an
automatically selected peak frequency are displayed after a brief
processing period.

(2] Graphic - File UC.S02.ABRD.miniseed

|"] ‘ T
uC_s027 o b
BT

Tam ' Tdm T T e T T e T

Time 1 Ampl. | Norm. [Indvidual ¥ | Offset (N0 | .

6) Atthis point it is possible to (a) remove bad time windows and (b) verify
that the selected processing parameters makes sense.
a) “Bad” time windows which yield outlier H/V curves or contain
excessive transient noise may be removed from the analysis. In the
“H/V Results” window, right click anywhere on the plot and select
“Reject time windows,” as shown in the figure below.

L0t f
File Edit Inset Format Tools

Properties Ctrl+Alt+P

Zoom Ctrl+Alt+Z
Zoomin Ctrl++
Unzoom Ctrl+-

Browse

Copy layers
Paste layers
Save layers
Append layers
Prepend layers

Frequency (Hz)

In the “H/V Results” window, click and drag over the specific time
H/V curves to be removed. Both the H/V curve(s) and the
corresponding time window(s) will be grayed out.
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(2] Graphic - File UC.502.ABRD.miniseed

fan T T T Tl T2 T s “lels
Time H Frequency (Hz)

Time 1 Ampl. 1 Norm. |Indvidual v Offset [No v/

Once the all of the H/V curves and time windows to be removed
have been selected and grayed out, in the “H/V toolbox” window =
“Time” tab, click the “Select” dropdown menu and select the “Clear”
option. In the pop-up “Removing time windows” window, click the
“Remove grayed” button.

Time Processing Output

Global time range
- B
To 35m0.0100s

Reference signal [ o

Time windows

General  Rawsignal  Filter  Filtered signal

[®] Removing time windows ? X
Length |Exactly v/ [60.00s. B

[Joverapby s.00% = You discarded some time windows (grayed). Do you really
want to remove all windows or only the grayed ones?

Bad sample
[ Tolerance 0,00, : Oeap |n.00s.
[ Threshold |absolute v | 0.00

o a0

] Ant-triggering on ra signal [Remove orayed]| cancel |

_____ 4
[ Anti-triggering on filtered signal

[ common [ Update
View |d stations ¥ | Number of windows Aute
Add
Renenie

Inverse

e
Once all the “bad” time windows have been removed, click “Start” in

the “H/V Toolbox” to reprocess the data.

Initially, H/V peak frequency is automatically picked. In order to
manually adjust the frequency band for peak picking, click the
“Tools” - “Edit peaks” menu in the “H/V Results” window. Select
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the peak details in the table in the “Peak editor” window, and then
click “Adjust”. The searchable frequency range from which the peak
is identified may be defined in the pop-up window, effectively
limiting peak selection. If multiple peaks are present, clicking the
“Add” button in the Peak editor window will add a new line to the
table which may also be adjusted, as described above. For this
example, an additional lower-amplitude peak frequency is searched
for and added between 0.20 Hz and 0.50 Hz.

et
0.5

[EER== | 9 peak editor

? X

Load results
Save results

Statistical comparison

Station

1 UC_s02

H/V

Type
133938

Frequency (Hz)

f-stddev (Hz)
1.16904

f+stddev (Hz)
1.50972

Set categories
Categories to groups
Groups to categories
Filter windows

[#] Peak search range

From [0.20Hz

2] to [0.51Hz

) =

i R T

] e [

Frequency (Hz)

The median and the confidence interval of computed H/V curves and the

picked H/V peak details should be exported to a text (.hv) file by clicking
the “Tools” menu = “Save results” option in the “H/V Results” window.
The figure should also be saved using the “File” menu = “Export image”
option.

For consistency and data archival purposes, the output text and image
files should be named using the site abbreviation. For this example, the
site abbreviation is “ARBD” and the text file is saved as “ARBD.hv”.

vﬁile Edit Insert Format Tt;:)l;

L’ Saving H/V results

=S

T
Frequency (Hz)

Look in:

| c:VocallHvsR_Example

|

? X

oo REME

Load results
S s My Computer

Edit peaks

Statistical comparison
Set categories
Categories to groups
Groups to categories

Filter windows

Name

Size

Type Date Modified

e, [0 o
Files of type: | HV file (hv) v|| Cancel

S e e e e e -

Reference:

http://www.geopsy.org/documentation/geopsy/hv.html
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H/V Spectral Ratio (HVSR) Data Archival Guidelines

To support further research, it is important to carefully document and properly
archive field testing data.

Each QuakeCoRE TP2 field testing project should be archived on the DesignSafe-
CI (https://www.designsafe-ci.org/), in its own project folder. The main project
folder should contain three items: (1) A project metadata file, (2) a RawData
folder, and (3) a ProcessedData folder.

It is important for each individual test/site, that the three or four letter test/site
name is consistent as listed in the metadata file, the raw miniseed data filename,
and the associated processed data filenames.

Metadata Requirements

A single project metafile should be produced following the format outlined in the
sample metadata file. This metadata will include the overall project details and
the details for each individual HVSR test/site.

Raw H/V Test Data — Sliced Waveform Files

The sliced test/site miniseed files are the HVSR “raw data” to archive for use by
other researchers interested in examining or reprocessing the data. Within a
project data archive folder, all of site/test miniseed files should be placed
together in a single “RawData” sub-folder, regardless of the field test date.

Analysed H/V Spectral Ratio Results — Text and Image Files

The processed HVSR data output from Geopsy includes two files: (1) the “hv”
text file with the frequency peak(s) and HSVR curve statistics, and (2) an image
file with the processed HVSR curves and picked peaks indicated for quick
visualization of the data. Each of these two files for each site/test should be
placed together in the single “ProcessedData” project sub-folder.
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